A stated General Meeting of the New York University Administrative Management Council was held on Tuesday, February 12, 2019 at 9:00 a.m., in Eisner and Lubin auditorium located on the 4th floor of the Kimmel Center for University Life at 60 Washington Square South. The meeting was convened with Mike McCaw as the AMC Chair. AMC Chair, Mike McCaw opened the meeting by welcoming members of the AMC and calling the meeting to order at 9:08 am.

I. Preliminary Matters  
A. Call to Order and Approval of Minutes  Michael McCaw

II. Reports  
○ Chairperson Report  Michael McCaw
  ■ NYU Work Life Balance Website is now live
  ■ Working group created to evaluate the Open AMC Ideas (first meeting in February/March)

○ Benefits
  ■ Kristi Schwindt Ramos announced as Vice Chair

○ Community Service
  ■ Community Service Leave Day Survey is out! Please fill out our survey.

○ Communications
  ■ The improved newsletter is out! We've received a ton of positive feedback and metrics.
  ■ Please nominate someone for the Behind the Title series.

○ Professional Development
  ■ Mentoring Mixer coming up for Tuesday March 12th
  ■ Resume Refresher coming up in Early April
  ■ AMC Mentoring Program Mixer | Tuesday, March 12th from 12:30 PM - 1:30 PM
  ■ AMC Resume Refresher | TBD late April/early May
  ■ Next Emerging Professionals Working Group Meeting | Thursday, March 7th from 1:00 PM - 2:30 PM ☝️ | 7 Washington Place, 4th Floor ☝️

○ A.I.D.E.
- Patti Pearson announced as Vice Chair

- Nominations and Elections
  - Nominations will open this semester for the following positions:
    - AMC Officers: Chairperson, Vice Chairperson, Secretary, Treasurer
    - AMC Senators: Three Senators and four Alternates
  - Representatives Schools/Units:
    - Dentistry, Global Public Health, Student Affairs, Meyers, Silver, Stern, Tandon, Tisch, Wagner, Office of the President, Provost Division, Student Affairs, EVP for Finance, EVP for Operations

III. Guest Presentations
A. NYU Digital Accessibility Policy Kitty Bridges
   1. Presentation attached
   2. NYU has adopted the World Wide Web Consortium’s Web Content Accessibility Guidelines.
   3. All new content must be accessible after August 1st 2018
   4. November 20th, 2020 is the next deadline, where all content from 1/1/2015 to 8/1/2018

B. NYU Finance Academy Eric Looffswold
   1. The NYU Finance Academy aims to provide a core set of competencies, including best practices and knowledge of NYU finance processes and policies and related technical skills, for administrators in finance related positions. (50% finance related job responsibilities)
   2. In-person, half day sessions (depending on content) on a monthly basis
   3. Required and Elective Courses
   6. Be sure to confirm your supervisor’s approval for participation and for funding support ($1,500 per participant).
   7. While this is a pilot, they hope to bring similar learning modules to the greater population of administrators and staff at NYU.

I. Senate Financial Affairs Committee Letter Carrie Meconis
   a. Final call for suggestions/edits

II. General Announcements
   a. Steinhardt’s Department of Music and Performing Arts Professions is hosting a number of events for Black History Month. For inquiries, please contact Amy Fair, Administrative Director, at amy.fair@nyu.edu
b. The LGBTQ Student Center has revamped the curriculum and branding of their Safe Zone training to ensure it is current and relevant in better serving and supporting LGBTQ+ students, faculty, staff, and alumni at NYU. Safe Zone is one of a collection of Zone trainings offered by the LGBTQ Student Center, Center for Multicultural Education and Programs (CMEP), Student Health Center, and Global Spiritual Life, which are branded under the umbrella One Zone.

III. Adjournment
   a. There being no more business, the meeting was adjourned by 10:30am

Respectfully submitted,

Alan Watson

AMC Secretary
Agenda

● Call to Order

● Reports

● Guest Presentations
  ○ Digital Accessibility
  ○ NYU Finance Academy

● General Announcements
Chair’s Report

Michael McCaw, IT

- **NYU Work Life website** is now live with upcoming events, information, and resources, such as “kinder emailing”

- OpenAMC Working Group will meet in late February/early March.
  - Representatives from the AMC standing committees and AMC Officers

- Recent OpenAMC Submissions
  - Executive officers term lengths and limits
  - Tree planting campaign throughout the NYU community
  - More sick days to care for family
  - No more [hardcopy] mail
Call to Order
Committee Chair Reports
Benefits Committee

Chair: Stevin Azo Michels, Tisch ; Vice Chair: Kristi Schwindt Ramos, FAS

amc.benefits@nyu.edu

- Members of the committee met with representatives from Carebridge (our employee assistance program), Trish Halley, AVP of Global Benefits, and Grace Cosachov Protos, Executive Director of Work Life.

- Next Benefits Spotlight on tuition remission tentatively scheduled for March 27th.
  - Focus on tax implications for tuition remission, financial aid, and course relatedness

- Participation in Work Life Focus Group for their new child care registry application.

- “Engaging Parent Networks at NYU” event will be held on February 28th.

- Next committee meeting:
  - Friday, March 1st from 12:00 PM - 1:00 PM
  - 721 Broadway, 11th Floor Conference Room
  - Link to full committee report
Community Service Committee

Chair: Carrie Meconis, Tisch
amc.community.service@nyu.edu

- **AMC Recycling Drive** is ongoing until March 1st.

- Used book drive will be March 4th - March 14th. Drop off locations will be posted on the AMC website.

- Community Service Leave Days survey is live! Please fill out this brief form.

- Next committee meeting:
  - Tuesday, February 19th from 12:30 PM - 1:30 PM
  - 721 Broadway, 9th Floor Conference Room
Communications Committee
Chair: Cassandra Bizzaro, Stern
amc.communications@nyu.edu

- AMC Monthly is out! Special thanks and kudos:
  - Kate Hogan (Silver); Katie Santo (DigiComm); Katrina Denney (FAS); Kristina Mclendon (Stern); Logan Johnson (DigiComm); Marcos Suazo (IT); Mike McCaw (IT); Wayne Cook (Procurement); Jahn Westbrook (Libraries); Leah McNally (Steinhardt); Mckenzie Love (Stern); Seamus Mullin (UHR)
  - Fun fact: Top click so far is the “Did you know?” museum link at the bottom of the email.
  - Be sure to check out the Behind The Title feature and nominate yourself or a colleague for a future spotlight.

- Next committee meeting:
  - Monday, March 4th from 12:00 PM - 1:15 PM
  - 40 West 4th Street, 5th Floor, Room T530
Inclusion, Diversity, and Equity Committee

Chair: Sangeeta Bhojwani, Meyers
amc.aide@nyu.edu

- Please welcome new co-chair, Patti Pearson!

- Pay Equity/Salary Transparency survey update

- “Closing the Wage Gap” workshop

- Partnership with AMC Professional Development Committee on resource directory of activities/affinity groups across NYU

- Next committee meeting:
  - Wednesday, February 20th from 9:30 AM - 11:00 AM
  - Kimmel Center, Room 703
Nominations and Elections Committee

Chair: David Vintinner, Institutional Research

amc.elections@nyu.edu

- Nominations will open this semester for the following positions:
  - AMC Officers
    - Chairperson, Vice Chairperson, Secretary, Treasurer
  - AMC Senators
    - Three Senators and four Alternates
  - Representatives
    - Schools: Dentistry, Global Public Health, Student Affairs, Meyers, Silver, Stern, Tandon, Tisch, Wagner
    - Units: Office of the President, Provost Division, Student Affairs, EVP for Finance, EVP for Operations
Professional Development Committee

Chair: Marni Vassallo, Steinhardt
amc.professional.development@nyu.edu

● Upcoming events:
  ○ AMC Mentoring Program Mixer
    ■ Tuesday, March 12th from 12:30 PM - 1:30 PM
  ○ AMC Resume Refresher
    ■ TBD late April/early May

● Next Emerging Professionals Working Group Meeting:
  ○ Thursday, March 7th from 1:00 PM - 2:30 PM
  ○ 7 Washington Place, 4th Floor

● Next committee meeting:
  ○ Thursday, March 7th from 3:30 PM - 4:30 PM
  ○ 239 Greene Street, 4th Floor
Senate Financial Affairs Committee

Senator: Carrie Meconis, Tisch
Alternate Senators: Stevin Azo Michels, Tisch; Nadia Cureton, Stern

- Review of revised draft for final comments and discussion
Guest Presentations
Kitty Bridges
Associate Vice President, Digital Accessibility
Interim Chief Information Security Officer
NYU IT
Eric Loffswold
Associate Director
Talent, Learning, and Organizational Development
University Human Resources
NYU Finance Academy

Eric Loffswold, UHR
Michael McCaw, PSO
Project Background

- The NYU Finance Academy aims to provide a core set of competencies, including best practices and knowledge of NYU finance processes and policies and related technical skills, for administrators in finance related positions.

- The NYU Finance Academy formalizes the work of the Finance Council working committee, which was further validated by survey results from the Administrative Process Improvement Initiative (APII) outreach in Spring 2018, specifically addressing respondents’ comments regarding:
  - Lack of training in fundamental financial concepts, systems, and processes at NYU
  - The sentiment that formal training, with real work execution, would be more helpful for development than an advanced academic degree
Program Structure

- In-person, half day sessions (depending on content) on a monthly basis

- Sessions facilitated by pre-selected NYU administrators and subject matter experts
  - Pre-work and post-work before/after each session
  - Sessions will consist of lecture, breakout exercises, team activities, debriefs, and application of concepts during and between sessions.
# Curriculum - Required Courses

<table>
<thead>
<tr>
<th>Content Area</th>
<th>Course Type</th>
<th>Instructor</th>
<th>Proposed Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introductory Survey Course</td>
<td>Core</td>
<td>Stephanie Pianka, HR, and Finance Leadership Team</td>
<td>April 30, 2019</td>
</tr>
<tr>
<td>Enterprise Risk Management</td>
<td>Core</td>
<td>Jasmine de Nully</td>
<td>May 29, 2019</td>
</tr>
<tr>
<td>Budgeting 1</td>
<td>Core</td>
<td>Daniel Feeley</td>
<td>July 18, 2019</td>
</tr>
<tr>
<td>Budgeting 2</td>
<td>Core</td>
<td>Daniel Feeley</td>
<td>August 13, 2019</td>
</tr>
<tr>
<td>Variance Reporting and Analysis</td>
<td>Core</td>
<td>Cathie Nadeau</td>
<td>September 17, 2019</td>
</tr>
</tbody>
</table>
# Curriculum - Elective Courses

<table>
<thead>
<tr>
<th>Content Area</th>
<th>Course Type</th>
<th>Instructor</th>
<th>Proposed Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not-For-Profit Finance, Treasury, Investment Management, Endowment, and Operations</td>
<td>Elective</td>
<td>Janine Wilcox, Jeff Rathgeber</td>
<td>September 26, 2019</td>
</tr>
<tr>
<td>Fundraising and Gifts</td>
<td>Elective</td>
<td>Helen Macleod-Brewer, Controller’s Division</td>
<td>October 2019</td>
</tr>
<tr>
<td>Sponsored Programs and Research Administration</td>
<td>Elective</td>
<td>Nancy Daneau, Jose Roman</td>
<td>November 2019</td>
</tr>
<tr>
<td>Financial Communication and Reporting</td>
<td>Elective</td>
<td>External</td>
<td>December 2019</td>
</tr>
<tr>
<td>Designing, Creating, and Validating Financial Models and Developing Tuition Forecasts</td>
<td>Elective</td>
<td>Internal</td>
<td>January 2020</td>
</tr>
<tr>
<td>Using Tools, including Artificial Intelligence to Automate Financial Transactions</td>
<td>Elective</td>
<td>External</td>
<td>February 2020</td>
</tr>
</tbody>
</table>
## Curriculum - Final Assignment

<table>
<thead>
<tr>
<th>Content Area</th>
<th>Course Type</th>
<th>Instructor</th>
<th>Proposed Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capstone Presentation highlighting synthesis and application of key concepts.</td>
<td>Core</td>
<td>Stephanie Planka, Eric Loffswold, Mike McCaw, and selected SMEs</td>
<td>Due by March 2020</td>
</tr>
</tbody>
</table>
Who would be a good candidate?

- High potential employee whose role has at least 50% responsibility in one or more of the following areas:
  - budget and planning, financial analysis, accounting and reporting, grants administration, financial compliance, financial operations, and treasury

- Someone who can benefit from an immersive curriculum

- Someone who can dedicate the time to the sessions and to applying concepts to their work
Measuring Participant Progress

● Modules and assignments will be based off of current school and university-wide projects to allow for “real time/real world” application.

● Progress will be assessed by participants’ progress on a comprehensive project that will focus on work within their department/school.
  ○ In addition, participants will be expected to:
    ■ complete assignments,
    ■ display an ability to define and explain key finance related best practices in a NYU setting, and
    ■ exhibit proficiencies in current technology and systems used to support finance at NYU.
Next Steps

   b. Be sure to confirm your supervisor’s approval for participation and for funding support ($1,500 per participant).

2. Submissions will be reviewed from March 1 - March 30, 2019.

3. All applicants will be notified of their status by early April 2019.
To apply:

For questions:

finance.academy@nyu.edu

Eric Loffswold, Project Lead
Mike McCaw, Project Manager
Senate Financial Affairs Committee

Senator: Carrie Meconis, Tisch
Alternate Senators: Stevin Azo Michels, Tisch; Nadia Cureton, Stern

- Review of revised draft for final comments and discussion
General Announcements
Steinhardt’s Department of **Music and Performing Arts Professions** is hosting a number of events for Black History Month. For inquiries, please contact Amy Fair, Administrative Director, at amy.fair@nyu.edu

- **Microaggression in the Workplace: How to Navigate and Support Each Other**
  Wednesday, February 20, 12:00 PM - 2:00 PM

  Fatihah Touray, Assistant Dean for International and Diversity Advising, College of Arts & Science will be speaking. The talk is open to faculty and administrators and is hosted by NYU Steinhardt in collaboration with the NYU College of Arts & Science.

- **Black History Month Family Storytime**
  Thursday, February 21, 10:00 AM - 12:00 PM

  This event is for children ages 4 and up and their caregivers. Space is limited to 30 children on a first come, first served basis.

- **Black History Month Celebration Through The Arts: A Tribute to Aretha Franklin**
  Friday, February 22, 7:00 p.m.
The LGBTQ Student Center has revamped the curriculum and branding of their Safe Zone training to ensure it is current and relevant in better serving and supporting LGBTQ+ students, faculty, staff, and alumni at NYU. Safe Zone is one of a collection of Zone trainings offered by the LGBTQ Student Center, Center for Multicultural Education and Programs (CMEP), Student Health Center, and Global Spiritual Life, which are branded under the umbrella One Zone.

- Visit the One Zone page to learn more about One Zone and how you can build in your allyship one Zone training at a time.

- To request a training, please visit tinyurl.com/nyusafezonerequest

- More information about how to register for an open Safe Zone training can be found on their website.
NYU LGBTQ Student Center Presents

SAFE ZONE

Revamped, modern, and relevant to supporting LGBTQ+ students at NYU today.

Safe Zone is a three hour training designed to provide foundational knowledge about LGBTQ communities, an understanding of some of the issues these communities face, and an awareness of various LGBTQ resources at NYU and beyond.

REGISTER TODAY

Friday
February 22
1 - 4 PM

Friday
April 12
1 - 4 PM

Open sessions are free to NYU graduate and undergraduate students, faculty, and staff.

tinyurl.com/nyusafezone2019

For group, organization, and departmental requests, go to: tinyurl.com/nyusafezonerequest

Priority Deadline: Monday January 28th

#nyusafezone
NYU Federal Credit Union is hosting a number of mortgage seminar dates throughout March. Seminars will be held at NYU Chemistry/Biology, Silver Center, 10th Floor Seminar Room (1003):

- **Not All Mortgages Are Alike - Know Which Mortgage is Right for You**
  - Thursday, March 7, 2019- 5:30 PM  7:00 PM

- **First Time Homebuyer: Your Roadmap and Your Options**
  - Thursday, March 14, 2019- 5:30 PM  7:00 PM

- **Mastering the Mortgage Process**
  - Thursday, March 21, 2019- 5:30 PM  7:00 PM

- **Impacts on Closing Costs and Interest Rates**
  - Thursday, March 28, 2019- 5:30 PM  7:00 PM
Exclusively for the NYU Community:

Your Dream Home is Closer than You Think

10% Down Payment Assistance Loans

Looking to Purchase a Home? Make it a reality!
Bridging the gap between your savings for home purchase and making that purchase a reality has never been easier!
10% Down Payment Assistance Loans* help you avoid paying Private Mortgage Insurance (PMI)
Fixed Rate Loan and Variable Rate Line of Credit Options Available
Mortgage Financing is available in all 50 states for first and second homes

* Meet most mortgage underwriting and credit score qualifications

Just call us at 212-995-3166
Email: nyucu@nyu.edu

New York University Federal Credit Union
www.nyucu.com
● **March AMC meeting** will be held on Tuesday, March 17th from 9:00 AM - 10:30 AM at the NYU College of Dentistry and NYU Meyers College of Nursing.

● Next **NYU Senate** meeting is Thursday, March 28th from 9:00 AM - 10:30 AM.

● AMC Senators are given one guest pass each for University Senate meetings. If you are interested to attend as a guest, please reach out to one of your AMC Senators:
  ○ **Regina Drew**, University Relations and Public Affairs
  ○ **Michael McCaw**, IT
  ○ **Carrie Meconis**, Tisch
  ○ **Carolyn Ritter**, Stern
  ○ **Katie Santo**, University Relations and Public Affairs
  ○ **Pamela Stewart**, Steinhardt
  ○ **Juan Tie**, Public Safety
amc.info@nyu.edu
Digital Accessibility

NYU Digital Accessibility Program
NYU IT Accessible Technology Services
Topics

1. What and Who
2. Why
3. When
4. How you can make an impact
   - Documents
   - Web content including videos
   - Social Media
   - Websites and web applications
   - NYU Classes
What is Digital Accessibility?

Ensuring that NYU websites, web applications, and digital content can be used by our diverse community, especially those who use a variety of assistive technologies.

Why?

1. NYU is committed to supporting an information technology environment that provides individuals who have a diverse range of hearing, movement, sight or cognitive abilities the opportunity to participate in University programs, benefits and services. NYU’s commitment to digital accessibility is grounded not only in principles of equity and inclusion, but also with the knowledge that accessible digital content generally enhances usability for everyone.

2. Virtually all of NYU’s academic and business activities have moved to the web: we need to make sure that everyone can use them.
About 15% of people have a disability ⇒ Over 1 billion people have some form of disability and between 110-190 million encounter significant barriers

253 million with vision impairments

360 million with hearing impairments

1 billion with neurological impairments
Ways people access/understand content

**Vision**
- Screen Readers
- Contrast changes
- Screen magnifiers
- Braille devices

**Motor**
- Keyboard only
- Voice input
- Eye control

**Auditory**
- Video captions
- Audio transcripts

**Cognitive**
- Clear & organized content
- Text-to-Speech
- Captions
Standards for Accessibility

**NYU’s Digital Accessibility Policy**  
Source: [NYU Website Accessibility Policy](#)

“New York University is committed to supporting an information technology environment that provides individuals with disabilities an opportunity to participate in the University’s programs, benefits, and services that is equal to that of their peers without disabilities.”

“NYU has adopted the World Wide Web Consortium’s Web Content Accessibility Guidelines (WCAG) 2.0, Level AA as its standard for digital accessibility.”

**Web Content Accessibility Guidelines (WCAG)**  
Source: [W3C](#) (World Wide Web Consortium)

- “...wide range of recommendations for making Web content more accessible.”
- “…testable statements that are not technology-specific.”
Digital accessibility benefits everyone.

Not just those with disabilities.
# Resolution Agreement Key Dates & Milestones

**Scope:** Websites, web application interfaces, web page content, PDFs and documents, video & audio. **Some exclusions exist for personal web pages, LMS contents and video descriptions.**

<table>
<thead>
<tr>
<th>Compliance Categories</th>
<th>Compliance Due Date</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>New Content &amp; Functionality</strong></td>
<td>August 1, 2018</td>
</tr>
<tr>
<td>Created, published, or substantially changed as of 8/1/2018</td>
<td></td>
</tr>
<tr>
<td><strong>Pre-existing Content &amp; Functionality</strong></td>
<td>November 20, 2020</td>
</tr>
<tr>
<td>Created, published, or substantially changed 1/1/2015 –</td>
<td></td>
</tr>
<tr>
<td>8/1/2018</td>
<td></td>
</tr>
<tr>
<td><strong>Legacy Content &amp; Functionality, Archived Content</strong></td>
<td>Upon request</td>
</tr>
<tr>
<td>Created or published prior to 1/1/2015</td>
<td></td>
</tr>
</tbody>
</table>
Top Ten Accessibility Checklist

1. **Page Title and Description**: Is your page title and description unique and clear?

2. **Page Layout**: Is your page content presented in a logical flow?

3. **Headings**: Are there section headings that separate content into segments?

4. **Heading Order**: Do headings descend in a logical way, e.g., Heading 1, Heading 2?

5. **Visibility**: Does the text on the page stand out against the background?

6. **Readability & Language**: Is content on the page easy to read? Is the language of the page identified?

7. **Links**: Do the links describe the destination clearly and are they easy to find?

8. **Image Descriptions**: Do all images convey a meaning and have descriptive text (alt tags)?

9. **Media Captions**: Do media have captions for audio and descriptions for information provided visually?

10. **Keyboard Controls**: Does your website enable access via keyboard only?
This boils down to

1. Organization & Semantics
2. Navigation & Wayfinding
3. Visibility & Readability
4. Media (Images, Graphics, Video)
Where can I make an impact?

How to Guides: nyu.edu/it/accessibility
Getting Started with this Work

Learn more about how those with disabilities use technology (videos, reading)

Start making things more accessible:

- **Documents**: Word, Google (soon), Adobe Acrobat Accessibility Checkers
- **NYU Classes**: Accessibility Assistant in the rich text editor
- **Web and CMS**: standards and techniques, training available
- **Video**: Use auto captioning with NYU Stream or YouTube and correct the captions
- **Images**: Add alt-text
- **Social Media**: caption, describe images

All described in slides below (will share with you), and on the Digital Accessibility website
Resources

NYU IT Digital Accessibility Website

Videos: Understanding the Impact
- Access - a short film about accessibility
- Accessibility 101
- Portland Community College student experience
- Developer Info
- Using Assistive Technology to Check Accessibility

Examples
- Good Keyboard Controls
- Good Screen Reader experience

Help, assistance, questions?
Email: digital-accessibility@nyu.edu
Make a Plan

1. New content
   Video captions, Audio transcripts
   Word docs
   PDFs
2. New templates

Take Action

1. Learn/get training
2. Start working with your content

Let Us Help You

1. Email us at digital-accessibility@nyu.edu
2. Visit the Digital Accessibility website at www.nyu.edu/it/accessibility
Documents
Documents, Powerpoints

1. Document organization
   - Use built-in styles or create your own heading structure
   - Use headings in logical order (h2, h3, h4) without skipping
   - Use built-in lists (bullets or numbered)

2. Images
   - If images, include alt text

3. Clear, easy to read
   - Use easy to read fonts (e.g. Arial or New Times Roman)
   - Ensure no content communicated by color or bold or italics alone
   - Ensure good color contrast

4. Use Office Accessibility Checker
Documents, Powerpoints (2)

Office Accessibility Checker

- Windows Office
- Office for Mac 2016+
- Dynamic accessibility feedback with instructions
Documents, Powerpoints (3)

Office Accessibility Checker

Available for:
- Word
- PowerPoint
- OneNote
- Excel
- Outlook
An accessible PDF begins with an accessible word processing document
Mac: Creating Accessible PDF from Word

1. File > Save As > PDF

2. Select Best for electronic distribution and accessibility (uses Microsoft online service)
Windows: Creating Accessible PDF from Word

1. File > Save As > PDF

2. Select Options > Document structure tags for Accessibility
What to Use for Scanned PDFs

 ✓ Personal/General Classroom Use: SensusAccess

 ✓ Public-facing Documents for Websites: Adobe Acrobat Pro
Scanned PDFs

1. For personal, or course-related materials (for example, internal documents or class handouts), use **SensusAccess**.
   a. Upload a document with varying formats
   b. Get a more accessible version emailed back
   c. Available via NYU Home
   d. Must use an NYU email address
   e. Should be checked after to ensure accuracy by using the **Adobe Accessibility Checker**

2. For public-facing (for example, forms, policy documents) or more complex PDFs (for example, image-heavy documents or brochures/catalogs)
   a. Use **Adobe** to ensure accessibility
How SensusAccess Works

1. Open SensusAccess (available on NYU Home)
2. Upload Document to Online Form
3. Tagged (more accessible) PDF sent to email
1. Select ‘Accessibility’ in the Tools menu
2. In the Accessibility menu, select ‘Full Check’
3. Select ‘Start Checking’ in the Accessibility Checker Options
4. Address each failed and manual check item

Right-clicking each item reveals automatic fixes or help on how to resolve.
Basic Web & Social Media Accessibility
Social Media

• Like other media types
  ○ Images need description (alt-text and/or caption)
  ○ Videos need captions
  ○ Simple clear language

• Hashtags
  ○ Use camel case for hashtags (the first letter of each word in a hashtag is capitalized), e.g., #GoViolets. A screen reader will read as separate words.

• See How to Guide for Social Media
Basic Web Highlights (1)

Page organization

● Page headings
  ○ Properly nest all page headings in descending order.
  ○ In the CMS, your page title is considered a H1 heading, so your first heading on the page should be a H2.
  ○ Ensure that headings go in order without skipping. You can go from a H2 to a H3, but not a H2 to a H4.
  ○ Don’t choose a heading level just based on how it looks.
Basic Web Highlights (2)

Page organization

● Lists
  ○ Use bulleted or numbered lists - not just lines of text that you manually edit.

● Tables
  ○ Avoid using tables for layout. Mark up tables properly when they are data tables.

● Links
  ○ Make sure text is clear (no “click here” or “read more”) and describes the purpose or destination.

● Keep content clear and easy to read
  ○ Use easy to read fonts (e.g. Arial or New Times Roman) of a good size
  ○ Ensure no meaning is communicated by color, bold or italics alone
  ○ Ensure good color contrast
Images and Graphics

- Images
  - Consider the purpose of your image. Is it important to understand the context of the page?
  - Images that provide information must have alt text.
    - Alt text should be “tweet length” (<=140 characters)
    - If the image is purely decorative, then the alt text should be coded as “” (empty).
  - Avoid using images of text or images with text overlaid:
    - Screen readers cannot read the image
    - Images with text may be hard to read on smaller screens or appear pixelated when magnified.
Basic Web Highlights (4)

Images and Graphics (con’t)

- Infographics
  - Infographics must also include alt text.
    - The alt text should be the **title** of the infographic with directions where to find the full text version.
    - The full text description should be located in the main body of your page, image caption, or within an Expandable component.
Basic Web Highlights (5)

The alt text here describes what the pie chart represents and where a user can find the full text description. Your full text description should always be directly below the pie chart.

alt="Pie chart showing distribution of NYU students across degree granting campuses in 2018, described in detail below."
Basic Web Highlights (6)

The alt text here describes what the pie chart represents and where a user can find the full text description. Your full text description should always be directly below the pie chart.

alt="Bar graph showing distribution of NYU freshmen across NYC residence halls in 2018"

2018 distribution of NYU freshmen across NYU residence halls bar graph text description
Audio & Video
Video and Audio

● Video
  ○ All videos should have closed captions (captions are different than subtitles)
  ○ Everything spoken is shown
  ○ Captions are correctly timed with video
  ○ Sounds are announced
  ○ Change of speaker is noted
  ○ Punctuation is present

● Audio
  ○ All audio files must have transcripts.

● Audio Description
  ○ Audio description of video provides information about actions, characters, scene changes, on-screen text, and other visual content. If there is visual content that is not adequately described by the audio, then you should add an audio description.
McCullough: "ALL THAT IS WITHIN ME,"
FRANKLIN ROOSEVELT ONCE WROTE,
Auto-Captioning

- NYU Stream and YouTube can automatically add captions
- Captions MUST be corrected manually
- Use the caption editors to ensure:
  - Accuracy
  - Sounds are announced: e.g. [applause]
  - Change of speaker announced
Transcripts

- Appropriate for audio files (e.g. podcasts)
- Not a substitute for captions for video, but can be offered in addition to captions
- Mostly same rules as captions:
  - Everything spoken is shown
  - Sounds are announced
  - Change of speaker is noted
  - Punctuation is present
Difference: Post-captions vs. Live captions

**Live captions**
- For videos that are live
- Held to high accuracy standard
- Some paraphrasing and mistakes are acceptable

**Post-captions**
- For videos that are static or edited (e.g. not live)
- Replay of live content requires post-captions
- Held to a very high accuracy standard (e.g. 100% accuracy!)
Post-Captioning Resources

- NYU Digital Accessibility Program website
  - How-to Guide for Video and Audio (Kaltura, You Tube)
  - Captioning Tipsheet
  - Creating open captions with Adobe Premiere Pro
  - Creating open captions using Handbrake

- Recommended language for event accommodations
- Federal plain language guidelines
Roadmap for Live Captioning

• **Future**
  ○ We're picking a vendor(s) soon to help with live captioning and post captioning
  ○ They’ll need advance notice (aim for a week)

• **Now**
  ○ Contact Marshall Sunnes at the Moses Center for assistance (ms9513@nyu.edu)
NYU Classes
NYU Classes

- Edit Content within NYU Classes
  - Use the same guidelines when editing/creating content in the Text Editor as with other content.
  - Use new Accessibility Assistant
- Multimedia
  - When creating multimedia use alt-text for images and captioning for videos
- Resources
  - Follow consistent folder structure and avoid confusing file names or file names with a long string of numbers/letters
- Page Content
  - Like Editing content you will want to follow the same guidelines for headers, images, hyperlinks, etc. and follow consistent structure
- NYU Classes Tools
  - NYU Classes main set of tools will be able to follow these guidelines. There may be additional considerations when using tools that are hosted by outside vendors
NYU Classes: Editor

Text Editor

The text editor in NYU Classes allows you to create/edit accessible content within the system.

NEW Accessibility Assistant will help with identifying and fixing basic accessibility issues (alt-text for images, heading nesting, tables).
NYU Classes: Headings

Mark text as a heading using the Format menu
NYU Classes: Images

- Add alt-text (alternative text) to images.
- You can modify alt-text when you add or edit an image.
How to Check if a Website is Accessible?
Quick Checks

Tab through the site - Does the tab move in the expected order? Do you know where you are (focus)? Did your tabbing point to things off screen (keyboard trap)? Can you move to the interactive content and interact with it with keyboard only (up-down arrows, space bar, enter key)?

Try a screen reader - Do all images have alt-text? Do all controls and forms have appropriate labels for the screen reader to read? Does the flow of information work? Do links and buttons indicate their purpose? Can you navigate through headings and landmarks?

Check the colors and color contrast - Do the colors (background and foreground) stand out enough for the low vision user (appropriate ratio)? Are you using color (or italics or bold) alone to communicate?

See accessibility review video from Google
How to Check Websites for Accessibility

Testing Resources:

- How to Test
- Testing Tools
- Testing Protocol (NetID/Password required)

Examples:

- Good Keyboard Controls: http://www.webaim.org
- Good Screen Reader experience: http://www.bbc.com